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Digital Conversion is one of five interconnected 
strategies to achieve extraordinary success

Learn
• Resources and the steps 

necessary to implement 
innovative practices that result 
in a digital ecosystem in their 
schools.

• Participants will gain an 
understanding that the most 
important considerations do 
not deal with technology, but 
with culture, instructional 
practices and student leaning.  

Take Away
• Questions to ask as you 

clarify your vision, mission, 
goals and strategies.

• Questions to ask during 
your digital conversion 
process, with the first being, 
“Why do we need to do 
this?”

Presenter
Presentation Notes
Coxsackie-Athens Central is in the third year of a digital conversion.  Some of our innovative practices include 1:1 mobile learning at the secondary level, expanding real time data access to all teachers and parents, online common assessments, digitizing backroom functions, migrating to cloud services, and expansion of our social media presence.  C-A continues to shift its practices towards a digital ecosystem with plans to enhance our library media services, and leverage technology to better align our assessments, curriculum and data.  



Outline of Session

• An Organizational Structure to support equity, 
innovation and change.
– Mission, Vision, Strategies, Targets

• Five Strategies to support equity, & innovation.
• Deeper dive into strategy of digital conversion

– Connections to other four strategies and vision and 
mission

– Bumps in the road, lessons learned
– Four Cornerstones of a digital conversion 

• Questions to ask



Educational Equity
All Students Learning at High Levels

Intervention-Behave as if you Believe

Assessment-Transparency Rules

Professional Practice –Learning is the Work

Curriculum-Connecting Peers with Purpose

Staff Development-Capacity Building

Organizational Development-

Systems Learn
Mission, Vision, Commitments, Structure

Randy Squier

Presenter
Presentation Notes
How coherent is your district? If coherence is less than perfect, what holds things back? 



Uniting our Vision and Mission

ENGAGE

Personalized Learning

INSPIRE
EXTRAORDINARY

SUCCESS

Presenter
Presentation Notes
Our mission and vision bolster our core purpose which is educational equity.  Where are your schools headed right now and what implications does this have for how teachers together can work more effectively?



District Coherence

“Large-scale success will occur only when 
system members begin to act from a shared, 
coherent mind-set. The only way to develop a 
shared mind-set is through purposeful and 
continuous interaction and learning over a 
period of time.”

Fullan pg. 104



Buttressing the 3 E’s

Professional
Learning Communities

Focus on Learning and 
Results in a 

Collaborative Culture

Engage
Empower

Enable

Presenter
Presentation Notes
These five strategies drive our actions and thoughts.The PLC is the base because collective inquiry by looking at best practices and current reality, being action oriented by learning by doing and experimentation, committed to continuous improvement and results oriented  all through the lens of the four learning questions will provide the how of the accomplishing the other four.  This is not about a good or great state of being, but rather a state of becoming extraordinary.  Extraordinary results occur when we have disciplined people, thought and action.  Disciplined people are we-centered, know our mission and vision is bigger than them but not bigger than us and have an intolerance for mediocrity.  



Elementary Three E’s

PLC’s

Continual cycle of 
collective inquiry 
centered on four 

learning questions

At the elementary level, the three
E’s are

Engage
Empower

Enable



Middle Level Three E’s

PLC’s

Continual cycle of 
collective inquiry 
centered on four 

learning questions

At the middle level, the three E’s
are

Engage
Empower

Enable



Secondary Three E’s

PLC’s

Continual cycle of 
collective inquiry 
centered on four 

learning questions

At the secondary level, the three
E’s are

Engage
Empower

Enable



Professional Learning Community

A PLC is an ongoing process in
which educators work collaboratively in
recurring cycles of collective inquiry and
action research to achieve better results
for the students they serve. Professional
learning communities operate under the
assumption that the key to improved
learning for students is continuous job-
embedded learning for educators.
As a PLC we will have a commitment to
continuous improvement by working
together to build shared knowledge on
the best way to achieve our aim high
results we seek for all students.
Working as a PLC is the foundation for
how we accomplish our targets, goals,
mission and vision.

Professional
Learning Communities

Focus on Learning and 
Results in a 

Collaborative Culture

Presenter
Presentation Notes
The ideas behind a PLC connect directly to the growth mindset concepts.  Each day we should be persevering to better answer in a systemic way the four learning questions.  Until everyone can “talk the walk” as Fullan states, we have not fully reached coherence.Each teacher must work to be able to communicate the most essential learning in their courses to their colleagues, students and parents.  Common assessments are a clear way to communicate what the teachers of a course value as most essential for a student to understand.  Not only the content of the assessment but the avenues a student may pursue to demonstrate proficiency is vital to supporting a student centered learning environment.     



Presenter
Presentation Notes
What do these effect sizes mean?An effect size of d = 1.0 indicates an increase of one standard deviation on the outcome – in this case the outcome is student achievement. A one standard deviation increase is typically associated with advancing children’s achievement by two to three years or improving the rate of learning by 50%. When implementing a new program, an effect size of 1.0 would mean that, on average, students receiving that treatment would exceed 84% of students not receiving that treatment.Hattie’s work is based on educational innovations. Research shows that these can be expected to have an average effect size of 0.4 (the “hinge point”). Innovations tend to capture the enthusiasm of the teacher and the excitement of the students attempting something new. So very few innovations have no positive effect at all. It is not unreasonable to claim that at least half of all implementations, at least half of all students, and at least half of all teachers can and do attain an effect size of d = 0.4 as a consequence of their actions. Therefore when analysing effects, we can say that anything with an effect size of over 0.4 is likely to be having a visible, positive effect.To put it another way, an effect size of 0.2 or less is low, 0.4 is medium and 0.6 or more is high.



The Principal’s New Role

Leading 
Learning

System 
Player

Agent 
of 

Change

One who moves people and 
organizations forward
under difficult circumstances.

One who contributes 
to and benefits from 
the increased 
performance of the 
others schools in the 
district and of the 
system as a whole.

One who models 
learning and shapes 
the conditions for all 
to learn. 

J. Quinn & E. Adam. Copyright © John 
Wiley & Sons, Inc. All rights reserved. 13



Urgency and Change 
“Big changes can’t be initiated 
without some terrible sense of 
urgency, but once we leave the 
starting blocks, the need is to 
focus our efforts.

Without focus, urgency makes 
things worse.”

J. Quinn & E. Adam. Copyright © John 
Wiley & Sons, Inc. All rights reserved. 14



Which type of urgency are you feeling?

 Accompanies 
persistent failure

 Anxiety, frustration, 
anger

 Frenetic activity to 
cure the problem

 Running from one 
unlikely solution to 
the next

False Urgency Focused Urgency

 Focused desire to win
 Sense of great 

opportunities 
coupled with hazards
 Relentless, fast 

moving, alert activity 
directed toward 
important issues

J. Quinn & E. Adam. Copyright © John 
Wiley & Sons, Inc. All rights reserved. 15



Purpose

Students with Purpose are inspired
to learn. The world has changed and a
vision for college, career and citizenship
readiness has emerged. Centered on
the concept that each student will have
a purpose and PATHWAY TO
SUCCESS, we will have an
uncompromising and relentless
commitment to preparing students for
college, career and citizenship; in other
words, preparing students
for their future. This will be
accomplished by creating relevant
learning environments, and interacting
with the people working in the
ecosystems of the career paths
students are working towards.



Pathways To Success
Providing Each Student with a Purpose



• They are clusters of courses that lead to careers that share 
common interests, skills and strengths. Each Pathway outlines 
the courses that will help you explore and develop the tools 
necessary for each career cluster.  Since there are many roads to 
success you are not locked into one Pathway.  If you change 
your mind you can explore another Pathway.

What are Pathways?



Is this a Career for you?
• Are you a creative thinker? 
• Are you imaginative, innovative, and 

original? 
• Do you like to communicate ideas? 
• Do you like making crafts, drawing, playing 

a musical instrument, taking photos, or 
writing stories? 

Media Arts
Careers in this path are related to the humanities and performing, visual, literary, and media arts. These include 

architecture; graphic, interior, and fashion design; writing; film; fine arts; journalism; languages; media; 
advertising; and public relations.

• Advertising and Public Relations
• Architecture
• Creative Writing
• Film Production
• Foreign Languages
• Interior Design
• Journalism
• Musician
• Performing Arts
• Radio and TV Broadcasting
• Web/Graphic Designer

Career Categories

• Computer Graphic Arts I
• Computer Graphic Arts II* 
• Art History*
• Webpage Design
• Photography*
• English Composition I*
• English Composition II*
• Blogcasting
• Publishing

• Music Theory
• Drama Club
• Yearbook
• Photography
• Choir/Band
• Studio in Art

• Public Relations Executive UG
• Dancer AA
• Film Producer AA
• Fashion Designer UG
• Journalist UG
• Radio and TV Broadcaster AA

Sample Careers and Levels of Education RequiredRecommended Electives 

Education Level Key: High School Diploma: D
1 to 2 Years Past High School: AA Undergraduate Degree: UG Graduate Degree: G

* Offered for College Credit



Is this a Career for you?
• Do you enjoy being a leader, organizing people,

planning activities, and talking? 
• Do you like to work with numbers or ideas? 
• Do you enjoy carrying through with an idea and 

seeing the end product? 
• Do you like things neat and orderly?
• Would you enjoy balancing a checkbook, follow-

ing the stock market, holding an office in a club,
or surfing the Internet?

Commerce
Careers in this path are related to the business environment. These include entrepreneur, sales, 

marketing, computer/information systems, finance, accounting, personnel, economics, and management.

• Accounting
• Auditor
• Banking
• Office Administration
• Business Ownership
• Economics
• Event Planner
• Insurance
• Loan Officer

• Personnel
• Hospitality/Tourism 

Management
• Computer/Information 

Systems
• Marketing
• Sales
• Finance
• Real Estate

Career Categories

• E-Commerce 
• Business Law *
• Computer Applications*
• Math Finance, Consumer 

Math
• Statistics*
• Sports and Entertainment 

Marketing 

• International Business
• World Languages
• Java(DL)
• Accounting
• Pre-Calculus

Loan Officer UG
Economist UG
Legal Secretary AA
Hotel Manager AA
Office Manager AA
Computer Programmer AA
Salesperson D
Travel Agent AA

Sample Careers and Levels of Education RequiredRecommended Electives 

Education Level Key: High School Diploma: D
1 to 2 Years Past High School: AA Undergraduate Degree: UG Graduate Degree: G

* Offered for College Credit



Is this a Career for you?
• Are you mechanically inclined and practical? 
• Do you like reading diagrams and blueprints, 

and drawing building structures? 
• Are you curious about how things work? Would 

you enjoy painting a house, repairing cars, wiring 
electrical circuits, or woodworking? 

Engineering Design Technologies
Careers in this path are related to technologies necessary to design, develop, install, and maintain physical 

systems. These include engineering, manufacturing, construction, service,
and related technologies.

• Architecture
• Precision Production
• Mechanics and Repair
• Manufacturing  Technology 
• Engineering and 

Related Technologies
Drafting

• Construction

• HVAC
• Building Trades
• Computer Services

Career Categories

• Design and Drawing for 
Production/STEM 

• Computer Aided Design
• Architectural Drawing  
• Material Processing  
• Product Design and 

Engineering*
• Residential Structures 
• Computer Aided 

Manufacturing (CAM)

• Robotics  
• Principles of Engineering*
• Studio Art
• Computer Graphic Arts I
• Computer Graphic Arts II
• DDP* 
• Calculus*
• Physics*

Architect G
Plumber AA
Electrician AA
Air Traffic Controller AA
Auto Mechanic AA
Chemical Engineer UG
Draftsman AA
Surveyor AA
Geographer UG

Sample Careers and Levels of Education RequiredRecommended Electives 

Education Level Key: High School Diploma: D
1 to 2 Years Past High School: AA Undergraduate Degree: UG Graduate Degree: G

* Offered for College Credit



Is this a Career for you?
• Do you like to care for people or animals who are

sick or help them stay well? 
• Are you interested in diseases and in how the body works? 
• Do you enjoy reading about science and medicine?
• Would it be fun to learn first aid or volunteer at a hospital

or veterinary clinic?
• Are you a nature lover? 
• Are you practical, curious about the physical world, and interested in 

plants and animals? 
• Do you enjoy hunting or fishing?
• Do you like to garden or mow the lawn? 
• Are you interested in protecting the environment?

Health & Environmental Services
Careers in this path are related to the promotion of health and treatment of disease, agriculture, the environment, 

and natural resources. These include agricultural sciences, earth sciences, prevention, treatment, and related 
health technologies. 

• Dentistry
Hygiene
Medicine
Nursing
Nutrition and Fitness
Therapy and Rehabilitation

• Agriculture
Animal Health Care
Earth Sciences

Environmental Science
Fisheries Management
Wildlife Management
Horticulture
Forestry
Life Science

Career Categories

• Certified First Responder
• Micro-Biology
• Anatomy
• Family Nutrition
• Adolescent Psychology
• Family Nutrition
• Psychology*
• Environmental Studies*

• Veterinary Science Dentist G
Dental Hygienist AA
Doctor G
Veterinary 
Technician AA
Respiratory 
Therapist AA
Physical Therapist UG

Farmer AA
Oceanographer UG
Physicist G
Landscaper D
Marine Biologist G
Conservation Agent UG
Chemist UG
Forester UG

Sample Careers and Levels of Education RequiredRecommended Electives 

Education Level Key: High School Diploma: D
1 to 2 Years Past High School: AA Undergraduate Degree: UG Graduate Degree: G

* Offered for College Credit



Is this a Career for you?
• Are you friendly, open, understanding, and

cooperative? 
• Do you like to work with people to solve 

problems? 
• Is it important to you to do something that makes 

things better for other people? 
• Do you like to help friends with family problems? 
• Do you like reading, storytelling, traveling, or 

tutoring young children?

Human Services
Careers in this path are related to economic, political, and social systems. These include education, government, 

law and law enforcement, leisure and recreation, military, religion, child care, social services, and personal 
services.

• Education
• Child and Family Services
• Law and Legal Studies
• Law Enforcement
• Cosmetologist
• Social Services
• Politics
• Government Service

• Military
• Hospitality & Hotels
• Parks & Recreation Director
• Fire Fighter
• Mental Health Counselor

Career Categories

• Certified First Responder
• Family Nutrition
• Adolescent Psychology
• Family Nutrition
• Psychology*
• Business Law*
• Composition I* & II*
• ASL

• Spanish*
• Statistics*
• Criminal Justice
• Adolescent Psychology
• Forensic Science

Chef AA
Teacher UG
Lawyer G
Police Detective AA
Cosmetologist AA
Social Worker UG
Librarian G
Firefighter AA

Sample Careers and Levels of Education RequiredRecommended Electives 

Education Level Key: High School Diploma: D
1 to 2 Years Past High School: AA Undergraduate Degree: UG Graduate Degree: G

* Offered for College Credit



Unifying Course

Service Learning

Science Living Sci. or Earth Sci.

Math Algebra I or Geometry

English Language Arts

LOTE

Social Sciences Global I

Fitness & Wellness

Unifying Reading

Year Long
Focus of Learning

• Individual passion and 
purpose are at the heart of 
creativity.

• Creativity and design thinking 
are at the heart of innovation.

• Innovation is an action.

• What is creativity?
• What is innovation?
• What does it mean to be 

an innovator?

Year 1
The Self as Innovator

Electives



Unifying Course

Service Learning

Science

Math

English Language Arts

Social Studies

LOTE

Fitness & Wellness

Unifying Reading

Year Long
Focus of Learning

• Innovation is creativity and 
design thinking in the context 
of time and place.

• What is the impact of context 
(time, place, culture) in 
innovation?

• What is the impact of 
innovation on its context 
(time place, culture)?

Year 2
Innovation in a Context

Electives



Action Research Student teams work on a real world 
challenge in their chosen pathway

College & Career 
Connections

Job shadowing, internships,
interviews

Community Service

Science 

Math

English Language Arts

Social Sciences

Fitness & Wellness

Unifying Reading

Year Long
Focus of Learning

• Innovation is a problem 
solving process that requires 
specific tools, procedures, and 
techniques.

• Innovation requires 
persistence and risk-taking.

• What are the tools, processes 
and techniques most critical 
for innovation?

• What is the role of persistence 
and risk in innovation?

Year 3
Innovation and Research

Electives



Capstone Exhibition Presentation of innovation 
created by student/or team

College & Career
Connections

Job shadowing, 
Internships, interviews

Community Service

English Language Arts

Social Sciences

Fitness & Wellness

Unifying Reading

Year Long
Focus of Learning

• Innovation is a force that 
moves society.

• Every person has the capacity 
to innovate.

• What drives innovation?
• What are the ethical dimensions 

of innovation?
• What kind of innovator am I?

Year 4
Innovation for the Future

Electives



Engage

Engaging Instruction is meaningful
and anchored in the real world. It is
evidenced in classrooms that employ
project-based learning that is standards-
based and learner-centered.
Students will be able to take advantage
of an atmosphere that matches their
learning styles and needs.
They will work side by side with their
teachers and classmates gathering and
sharing necessary information to solve
real-world problems.
Students will learn to work successfully
with others while taking personal
responsibility for becoming an effective
team member.









Empower

Empowerment helps provide efficiency
and efficacy to our students that support
their development of the ‘4Cs’
(Collaboration, Communication, Critical
thinking and Creativity) . These self-
directed characteristics will not only help
our students be college, career and
citizenship ready, these characteristics will
help our students all of their lives.
Teachers build professional capital by
utilizing the expertise of other teachers to
make expert decisions that improve
student learning. Teachers are able to
explain very clearly what they are doing in
the classroom and why.
Together, teachers and students believe
they can improve and become smarter
each day.



Respect, 
Responsibility

& 
Concern

Self-
Esteem

Personal 
Skills

Think & 
Learn

for 
Understanding

Quality 
Producer

Presenter
Presentation Notes
To reproduce the SmartArt effects on this page, do the following:On the Home tab, in the Slides group, click Layout, and then click Blank. On the Insert tab, in the Illustrations group, click SmartArt.In the Choose a SmartArt Graphic dialog box, in the left pane, click List. In the List pane, double-click Horizontal Picture List (third row, third option from the left) to insert the graphic into the slide. Press and hold CTRL, and select the picture placeholder and text shape (top and bottom shape) in one of the objects. Under SmartArt Tools, on the Design tab, in the Create Graphic group, click Add Shape, and then click Add Shape After. Repeat this process one more time for a total of five picture placeholders and text shapes. Select the graphic. Under SmartArt Tools, on the Format tab, click Size, and then do the following:In the Height box, enter 4.44”.In the Width box, enter 9.25”.Under SmartArt Tools, on the Format tab, click Arrange, click Align, and then do the following:Click Align to Slide.Click Align Middle. Click Align Center. Select the graphic, and then click one of the arrows on the left border. In the Type your text here dialog box, enter text.Press and hold CTRL, and then select all five text boxes in the graphic. On the Home tab, in the Font group, select Corbel from the Font list, and then enter 22 in the Font Size box.Select the graphic. Under SmartArt Tools, on the Design tab, in the SmartArt Styles group, do the following: Click Change Colors, and then under Colorful click Colorful Range – Accent Colors 2 to 3 (second option from the left).Click More, and then under Best Match for Document click Moderate Effect (fourth option from the left).Select the rounded rectangle at the top of the graphic. Under SmartArt Tools, on the Format tab, in the Shape Styles group, click the arrow next to Shape Fill, and then under Theme Colors click White, Background 1, Darker 35% (fifth row, first option from the left).Click each of the five picture placeholders in the SmartArt graphic, select a picture, and then click Insert.To reproduce the animation effects on this slide, do the following:On the Animations tab, in the Animations group, click Custom Animation.On the slide, select the graphic. In the Custom Animation task pane, do the following:Click Add Effect, point to Entrance, and then click More Effects. In the Add Entrance Effect dialog box, under Moderate, click Ascend. Under Modify: Ascend, in the Speed list, select Fast.Also in the Custom Animation task pane, click the arrow to the right of the animation effect, and then click Effect Options. In the Ascend dialog box, on the SmartArt Animation tab, in the Group Graphic list, select One by one.Also in the Custom Animation task pane, click the double-arrow below the animation effect to expand the list of effects.Also in the Custom Animation task pane, do the following to modify the list of effects:Select the first animation effect, and then do the following:Click Change, point to Entrance, and then click More Effects. In the Change Entrance Effect dialog box, under Moderate, click Compress. Under Modify: Compress, in the Start list, select With Previous.Press and hold CTRL, select the third, fifth, seventh, ninth, and 11th animation effects (effects for the text shapes), and then do the following:Click Change, point to Entrance, and then click More Effects. In the Change Entrance Effect dialog box, under Basic, click Peek In, and then click OK. Under Modify: Peek In, in the Direction list, select From Top. Under Modify: Peek In, in the Speed list, select Fast.Press and hold CTRL, select the second, fourth, sixth, eighth, and 10th  animation effects (effects for the pictures). Under Modify: Ascend, in the Start list, select After Previous.To reproduce the background effects on this slide, do the following:Right-click the slide background area, and then click Format Background. In the Format Background dialog box, click Fill in the left pane, select Gradient fill in the Fill pane, and then do the following:In the Type list, select Linear.Click the button next to Direction, and then click Linear Down (first row, second option from the left).Under Gradient stops, click Add or Remove until two stops appear in the drop-down list.Also under Gradient stops, customize the gradient stops as follows:Select Stop 1 from the list, and then do the following:In the Stop position box, enter 0%.Click the button next to Color, click More Colors, and then in the Colors dialog box, on the Custom tab, enter values for Red: 130, Green: 126, and Blue: 102.Select Stop 2 from the list, and then do the following: In the Stop position box, enter 71%.Click the button next to Color, and then click Black, Text 1 (first row, second option from the left). 



Personal Skills

Work 
with a 
group Problem 

solve

Make 
decisions

Communicate

Set 
goals

Presenter
Presentation Notes
Goal orientation is a narrower concept than student motivation. Defined by Caraway, Tucker, Reinke, and Hall (2003) as the individual's ability to make plans and set goals, it works in conjunction with self-efficacy to increase motivation. Goal-oriented individuals set challenging goals for themselves and maintain high levels of commitment to those goals despite encountering obstacles or challenges.



Self-Esteem

Living consciously, 
actively 

and responsibly

Understands risk, 
accepts uniqueness

Accepts power 
& freedom to 
make choices

Has Fun

Presenter
Presentation Notes
Locus of control is defined by Rotter (1966, in Miller, Fitch, & Marshall, 2003, p. 548) as "the tendency students have to ascribe achievements and failures to either internal factors that they control (effort, ability, motivation) or external factors that are beyond control (chance, luck, others' actions)." A self-directed learner would have a higher internal locus of control than an external one. 



Responsible for
• actions
• words

Demonstrates
• respect
• Pride in self, 

others, 
school & 
community

Respects
• Individual 

Differences



Quality 
Producer

Has strong 
work ethic.

Ability to 
assess own 
work and make 
improvements.

Ability to set 
high goals & 
standards, 
and meet 
them.



Life long 
learner

Knows how 
to use 

information

Utilizes 
technology 
effectively

Directs own 
learning

Presenter
Presentation Notes
Self-efficacy is defined as "people's judgments of their capabilities to organize and execute courses of action required to attain designated types of performances" (Bandura, 1986, in Linnenbrink & Pintrich, 2003, p. 120). Self-efficacy is different from self-esteem in that it is a personal judgment of competence, rather than an emotional reaction to actual accomplishments. Self-efficacy is more specific to a task (e.g., "I can reduce fractions correctly") instead of a generalized notion of competence (e.g., "I am good at math").Linnenbrink and Pintrich (2003) describe three important components linked to self-efficacy: behavioral engagement, cognitive engagement, and motivational engagement. Behavioral engagement is the observable behavior a teacher can see in classrooms when students are working on a task. Cognitive engagement is thinking critically, taking advantage of different learning strategies, and using metacognition. Motivational engagement includes the student's personal interest in a task and his perceptions of the utility value and general importance of the task. A higher level of motivational engagement has been shown to increase student achievement.Metacognition is the ability of the student to analyze, reflect on, and understand her own cognitive and learning processes. Students who identify appropriate learning strategies in the right context are using metacognition. For example, a student may know that she has trouble picking out the main idea in a reading passage. If she has been taught a simple graphic organizer—such as webbing—to identify the main idea, and then chooses on her own to map out the passage in a web, then that student has used metacognition to complete the task. Students who are aware of their own cognitive strengths and weaknesses are more likely to be able to adjust and compensate for them.Self-regulation is the ability of the learner to control interest, attitude, and effort toward a task or a goal. The key to self-regulation is the ability of the learner to understand the requirements of the task or goal, and then to monitor and adjust his effort without reminders, deadlines, or cues from others such as teachers, peers, or parents. A student who has a clear understanding of an academic task (e.g., "I must write a five-paragraph paper tonight") can then implement self-regulation to meet the requirements of the task (e.g., "If I write an outline first and then utilize the writing strategies I have been taught, I can get a draft done in 90 minutes"



Enable

Enabling every student and teacher
with technology to unite them with the
world, allowing them to connect with the
information they need when they need it
and to join them to the people in the
world with whom they need to connect.
Technology will redefine learning for all
students by allowing teachers to blend
the learning environment through
various media as well as recreate
authentic learning experiences.
Students will be able to go beyond
consuming information to examine
topics in greater detail and take
personal responsibility for their
education outside the school walls.
They will have access to state of the art
technology to discover the world that
surrounds them.



Curriculum

•Teachers will create a digitally enhanced curriculum that redefines how to deliver 
instruction in a blended learning environment(digital and paper) while concurrently raising 

expectations with new academic standards that place greater emphasis on the 4Cs 
(Collaboration, Communication, Critical thinking and Creativity). To prepare globally 
competitive graduates, technology will be integrated into all academic disciplines.

Instruction

•Teachers will facilitate learning that includes the use of technology where appropriate. C-A 
will develop and provide an interface for students and teachers to access blended 

curriculum content including digital resources for teaching and learning. 

Assessment

•C-A will give teachers the ability to easily access and administer curriculum-aligned 
formative and summative assessments.  Benchmark results, as well as other assessment 
results and classroom grades, will be accessible through a common portal . Our system 
wide grade book  and data dashboard platform will be utilized by all teachers, with real-

time access for students and parents. 

People 
Capacity

•C-A will build capacity through continuous differentiated professional learning 
opportunities identified via an ongoing communication loop in order to provide relevant 

needs based support.  Teachers will be empowered to deliver instruction in ways that 
enables and engages all students.

Infrastructure

•C-A has recently installed a wireless network in all our schools.  We will continue to update 
our  servers, and other hardware to support our digitial conversion.  Hardware will become 

inconspicuous tools in teachers and students anytime learning journies. 

Budget & 
Policy

•C-A will continue to leverage state aid and our partnerships with venders  to provide the 
resources needed by teachers and students.  Policies will be reviewed and updated if 

necesary to provide students a safe environment to develop the attributes necessary to 
become responsible citizens.



Data

Student 
Information 

System

Learning 
Management 

System

Curriculum 
Map

Cloud 
Services

Software

Platforms

Infrastructure

Digital 
Resources

Digital 
Textbooks

Online 
Databases

Academic 
Research 
Platforms

Applications

Classroom 
Interactivity

Productivity

Subject Area

Reference 
Materials

Assessments

Cornerstones

http://www2.classbook.com/



Supporting Standards

Learning 
Standards

CCSS
ISTE
ALA

Professional 
Standards

Teacher
Librarian

Administrator

4
Cornerstones

http://www2.classbook.com/



Data

Student 
Information 

System

Learning 
Management 

System

Curriculum 
Map

Cloud 
Services

Software

Platforms

Infrastructure

Digital 
Resources

Digital 
Textbooks

Online 
Databases

Academic 
Research 
Platforms

Applications

Classroom 
Interactivity

Productivity

Subject Area

Reference 
Materials

Assessments

Capacity Building

Strategic:
Cornerstones I, II, III

PD for everyone or a group with common students

Tactical
Cornerstones III, IV

Specific to a teacher or class
Ongoing, 1:1, Coaching

http://www2.classbook.com/



Data

Student 
Information 

System

Building The Cornerstones

Does your current SIS provide the 
information you need easily?

Do your teachers 
and parents “love 

it?”
Is the juice worth 

the squeeze?

Looking at other SIS options
•Time
•Cost
•Training and follow-up
Would another database platform 
layered on your SIS work?

Changed SIS to one that was BOCES 
supported, use EdVista for data 
dashboard

Lessons:
Test drive more SIS

Have wider stakeholder input



Data

Learning 
Management 

System

Building The Cornerstones

What actually is a Learning 
Management System?

Do your teachers 
already use one or 

many? Looking at LMS options
•Time
•Cost
•Training and follow-up

How do we avoid, 
“new car off lot” 

paralysis by 
analysis ? 

System-wide, 
grade level or vary 

by classroom? 

Teachers are using Google drive, My Big 
Campus, Website, Edmodo.
Lessons:

At some point we can’t support all.
Need to settle on building wide



Data

Curriculum 
Map

Building The Cornerstones

What are your current curricular 
organizational needs?

How much time 
upfront  to 
populate? Looking at curriculum mapping 

platforms
•Time
•Cost
•Training and follow-up
•UpdatingAccess to modify 

for all or a few 
gatekeepers

Can the platform 
connect to SIS, 

data dashboard?

What’s out there 
working?

We have nothing.
Lessons:

Good spot since we have no paper 
curriculum either.



Cloud 
Services

Software

Platforms

Infrastructure

Building The Cornerstones

Do we have the 
bandwidth, 

both inside and 
outside?

•Savings 
•Free up time
•Access 
anywhere
•Back office & 
classroom & 
library

How long will  
infrastructure 

stay current? Or 
is it already too 

old? 

What cloud 
services are we 
currently using? 

Go full cloud or 
blended for 
classroom 

productivity 
tools?

We have been moving there slowly-FM, 
schooldude

Lessons:
Looking at filtering

Make sure switches are ready



Digital 
Resources

Digital 
Textbooks

Online 
Databases

Academic 
Research 
Platforms

Building The Cornerstones

•Training and 
exposure
•Tech support

Devices 
compatible?

Licenses, who 
owns them?

What current 
books are 

accessible via 
digital formats

What is your 
librarian using 
and want to 

use?

How will you 
manage 
licenses?

Not all e-books 
are equal- Do 
they augment 

or modify what 
teachers and 

students need?

Utilize library services, virtual fieldtrips
We brought in 3rd party consultant to wade through options. 
Online credit accrual and recovery 

Lessons:
Test each e-book format before purchasing.
Plan ahead how to put licenses on devices



Applications

Classroom 
Interactivity

Productivity

Subject Area

Reference 
Materials

Assessments

Building The Cornerstones

System-wide, 
building wide 
or classroom 

for productivity 
tools?

Can a platform 
handle more 

than one need?

What is already 
being used ?
What is being 
paid for and 

not being used? Will online 
assessments 

make life easier 
for teachers?

Compatibility

Library

Added embedded training.  Have all 
common assessments online. Productivity 
platforms acting as LMS’s, Distance 
Learning, piloted PARCC

Lessons:
Some folks just like paper/binders



Digital Ecosystem Future 
MAKER LEARNING
• Capital Region is home to an emerging community of DIY makers, tinkerers, inventors, and innovators of all ages. In and out 

of schools, makers combine physical and digital skills from science and engineering, technology and media, crafting, and the 
arts to learn how to work together to reshape the world around them.

DIGITAL LEARNING
• Digital literacy is an essential and foundational skill for all children and youth today. From coding for the web and 

programming mobile apps to practicing good web citizenry, Digital Learning programs in C-A are helping equip today’s digital 
natives for a future they will make for themselves.

STEAM LEARNING
• STEAM Learning emphasizes the integral role of arts and creativity in the learning process for science, technology, 

engineering, and mathematics. In C-A, educators are incorporating STEAM education into curricula.
GAMING & PLAY
• Good games, like good learning experiences, motivate players to achieve mastery. By scaffolding gaming tropes like peer 

competition, quest-based challenges, and ongoing merit-based rewards with clear goals for learning, games create 
opportunities for children and youth to connect their interests with academic success.

ROBOTICS & COMPUTER SCIENCE
• C-A sees these fields as vital to the Capital Region economy. Innovations in these fields have found application in community 

settings and consumer products designed to enhance children’s learning, creativity, and development.
YOUTH MEDIA
• Media saturates our daily lives and affects how we understand and engage with the world. Young people must not only 

develop a deep understanding of how that media is created, they must learn to create it themselves.

Presenter
Presentation Notes
If we think of an ecosystem as an interconnected community of independent organisms who interact within a given environment and form a self-supporting system, then Kids+Creativity could perhaps be described as the learning innovation ecosystem of the Pittsburgh region.Just like in an ecological system, no one organism (or in our case organization) possesses all of the elements necessary to sustain itself or the environment. It’s only through the combined properties of individual system components working together in concert that life and growth (or in our case learning and creativity) can be sustained.Already in Pittsburgh, educators and leaders working in formal and informal settings are responding to important social and technological shifts that are changing the context for learning in the 21st century. They are making use of new tools and resources, as well as capitalizing on the emergent interests and fluencies possessed by today’s generation of young digital natives, to transform Pittsburgh into a model for collaborative, creative, and connected learning.We’ve come to understand this organic tendency as part of a model that resembles an ecosystem, composed of five key elements:.



Design Thinking - Digital Ecosystem
• Design thinking to schools, “is a set of tools, methods, and 

processes by which we develop new answers for challenges, big and 
small. Through applying design thinking to challenges, we learn to 
define problems, understand needs and constraints, brainstorm 
innovative solutions, and seek and incorporate feedback about our 
ideas in order to continually make them better.”

• Design thinking is what engineers and other problem solvers do: 
they identify the problem and work backward to a solution. But 
that’s not as simple as it sounds. It requires the ability to unpack a 
lot of information—and not get lost in the process—cull the 
elements that can lead to a solution, and keep the bigger system—
whether an ecosystem or a political system—

Presenter
Presentation Notes
http://www.designforchange.us/ http://www.popcitymedia.com/features/elizabethforward103112.aspxhttp://www.efsd.net/files/_5CBJL_/d6aa6674e7a0a8723745a49013852ec4/ef_schools_recognized_for_high_tech_efforts__pg_1-23-2014.pdf http://blogs.mtlakes.org/nothingbutnet/2014/06/13/maker-spaces-at-mlhs/http://remakelearning.org/project/entertainment-technology-academy/ http://remakelearning.org/project/dream-factory-efms/ http://remakelearning.org/blog/2014/10/09/design-thinking-in-schools/ 
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Cornerstones

http://www2.classbook.com/



Strategies to Support the 3 E’s

Professional
Learning Communities

Focus on Learning and 
Results in a 

Collaborative Culture

Engage
Empower

Enable



Resources

• Fullan, Michael; The Principal, Wiley & Sons, 
2014.

• DuFour, DuFour, Eaker; Learning By Doing, 
Solution Tree, 2006.

• Hattie, John; Effect Size Presentation, SCEE 
Conference, 2014.

• http://www2.classbook.com/
• http://www.allthingsplc.info/tools-resources
• http://www.solution-tree.com/free-repros

http://www.allthingsplc.info/tools-resources
http://www.allthingsplc.info/tools-resources
http://www.solution-tree.com/free-repros
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